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The MIST program has been developed to provide users with a general application to 

model an integrated scattering system.  The program performs an integration of the 

bidirectional reflectance distribution function (BRDF) over solid angles specified by the 

user and allows the dependence of these integrals on model parameters to be investigated.  

The models are provided by the SCATMECH library of scattering codes.  

1. Introduction 

Light scattering is widely used by scanning surface inspection tools to inspect materials, such as silicon 

wafers, flat panel display substrates, data storage media, and optics, for defects, particles, and surface 

roughness. These instruments often direct collimated or lightly-focused light at a sample and collect 

scattered light with one or more large optics. The optics collect light over significant solid angles in order 

to maximize sensitivity.  When designing these instruments, it helps to be able to predict the signal for 

different geometric conditions and model parameters. 

The BRDF characterizes the directional dependence of the scattering by a material.  The BRDF is given 

by 
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where Φs is the power scattered into solid angle Ω, centered on polar angle θs and azimuth angle φs, and Φi 

is the power incident on the sample at an angle θi. The angles θi, θs, and φs are defined in Fig. 1.  The 

function 
r i s s( , , )f θ θ φ also depends upon the polarization state of the incident light and the polarization 

sensitivity of the detection system. Any optic collecting light over a finite solid angle measures a 

reflectance given by 
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If we make a change of variables, s scosξ θ φ=  and s ssinη θ φ= , then Eq. 2 becomes  
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Ω

Ω = ∫  (3) 

Eq. (3) is slightly easier to use than Eq. (2), since the differentials can be made more uniform over the 
collection aperture. 

The MIST program uses theoretical models for the BRDF which are supplied by the SCATMECH 

library and calculates the quantity ρ(Ω) using Eq. (3) for geometries specified by the user.  Furthermore, 
MIST allows the user to vary parameters in the model or in the definition of the solid angle, providing the 

user with the dependences on those parameters. 

Besides using it as a design tool, one application of MIST is the development of calibration curves for 

an instrument.  For example, the absolute response of an instrument to spherical particles can be accurately 

determined as a function of the particle size using the SCATMECH model 

Bobbert_Vlieger_BRDF_Model.  If a set of reference particles are used to calibrate the instrument, 

then these calibration curves can be used to interpolate (or even extrapolate) to other particle sizes.  The 
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advantage of using a model-based calibration curve, over using non-physically-based interpolation 
techniques, is that it is more accurate and the calibration should not change if the set of reference particles 

changes.  Furthermore, a smaller number of reference particles are needed for calibration, and over 

sampling of the calibration curve provides information about uncertainties in the measurement and can 

compensate for uncorrelated uncertainties in the reference particle diameters. 
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FIGURE 1    The scattering geometry and angle convention used by 

the calculations.  The incident angle is θi.  The scattering direction is 

defined by polar angle θs and azimuth angle φs. 

2. Installing MIST 

The MIST software package is supplied in a self-extracting executable file (MISTzip240.exe). To 

install the software, the user should run mistzip240.exe from a temporary directory.  The program 

will create a directory (C:\MIST by default) and extract files into this directory.  

3. Running MIST 

MIST is a 32-bit Windows* application. To run MIST, find the folder containing the executable 

program and double-click on its icon.  You can create a shortcut to the program by right-clicking on the 

icon, then choosing “Create Shortcut.”  The shortcut can then be moved to the Start Menu or the Desktop. 

4. Model Browser 

The Model Browser allows the user to view information about all the SCATMECH models and can be 

opened by selecting “Model Browser” from the menu.  The window has three frames.  The left frame 

provides a tree structure view of all of the SCATMECH model classes.  The top right frame provides a 

synopsis of the model highlighted in the left frame.  The bottom right frame provides a listing of all of the 

parameters, their descriptions, their data types, and their default values.  More information about the 

models can be obtained from the SCATMECH documentation. 

                                                        
* Certain commercial products are identified in this documentation in order to describe the software 

adequately. Such identification is not intended to imply recommendation or endorsement by the National 

Institute of Standards and Technology, nor is it intended to imply that the products are necessarily the best 

available for the purpose. 
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5. MIST Wizard Document 

The MIST Wizard Document format is the preferred way to provide instructions for MIST to determine 

the integrated reflectance.  A new document may be opened by selecting the menu item File→New and 

then selecting “MIST Wizard Document.”  A saved document may be opened by selecting File→Open.  A 

saved MIST Wizard Document will contain not only the instructions to generate the integrated reflectance, 
but also data from the last calculation.  A document appears as a tree structure containing eight top level 

elements: 

 

In the following subsections, each of these elements will be described in detail. 

5.1 MODEL Wizard Element 

The MODEL wizard element defines which SCATMECH BRDF model will be evaluated during 

integration.  If you double-click on it, or select the element and press enter, a dialog box will open, which 
will allow you to choose a model from the selection of available models and provide a comment for 

annotating the document: 

 

After pressing the OK button, the document will show the new model name, and will provide the model 

parameters with their default values in the MODEL PARAMETERS section (described in Sec. 5.4 below): 
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5.2 USER VARIABLES Section 

The USER VARIABLES section allows the user to define variables that can be used to make the 

calculation easier or more straightforward to the user.  Some variables come predefined and are optional:   

 

Other variables can be added, removed, edited, copied, or pasted by selecting any of the variables and 

right-clicking the mouse.   The order of the variables may be changed by dragging any with the mouse or 

by selecting any and pressing CTRL and either the up button or the down button. If a new variable is being 

created or a current variable is being edited, then a dialog box will appear: 

 

The variable name can be any alphanumeric string containing no whitespace.  The value can be any 

arithmetic expression using previously defined variables.  See Sec. 9 below for further description of 

expressions. 

5.3 REQUIRED VARIABLES Section 

The REQUIRED VARIABLES section allows the user to define five parameters that are required 

during the calculation of integrated scatter: 

 
The order of the required variables may be changed by dragging any with the mouse or by selecting any 

and pressing CTRL and either the up button or the down button. If the user double-clicks on any of these 

parameters, a dialog box will open, allowing the user to edit the parameter value. The interpretation of each 

variable is defined below: 
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DIFFERENTIAL – The approximate differential solid angle (in steradians) used during the 

integration.  The smaller this value, the longer the calculation will take, but the more accurate the results 

will be.  A reasonable value for a fast calculation can be obtained by a value of 0.001, which corresponds to 

a grid spacing of about 2°×2°.  

MINSAMPLES – The minimum number of samples for any integration.  If the total solid angle of the 

integration is close to or smaller than DIFFERENTIAL, then the program will use a smaller differential 

solid angle.  It is best to set this value to about 10. 

INCIDENTANGLE – The incident angle (in radians) of the incoming light.   

INCIDENTPOL – The Stokes vector intensity for the incident light.  The Stokes vector should have a 

unit intensity in order for the results to be interpreted as a reflectance.  Common incident Stokes vectors are 

shown in the table below: 

(1,0,0,0) unpolarized incident light 

(1,-1,0,0) p-polarized incident light (E-field in the plane of incidence) 

(1,1,0,0) s-polarized incident light (E-field perpendicular to the plane of incidence) 

(1,0,1,0) 45° polarized incident light 

(1,0,0,1) left-circularly polarized incident light 

 

ROTATION – The rotation angle (in radians) of the sample about the surface normal.  If this 

parameter is zero, then the light is incident along the fiducial direction of the model.  If the scattering model 

is for an isotropic surface, this parameter is ignored. 

5.4 MODEL PARAMETERS Section 

The MODEL PARAMETERS Section lists the parameters in the model, allowing the user to edit them: 

 
Some parameters are models themselves and may have sub-parameters.  For example, if the user double 

clicks on psd above, the following dialog box opens: 

 
The user can then select among the possible models for that parameter. When the user presses OK, all 

of the sub-parameters are updated with their default values. Double-clicking on other parameters will open 

the following dialog box: 
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If the box marked “Transfer directly as a string to model” is not checked, then any arithmetic 

expression may be used for the value, using any parameters defined above it, and that the parameter may be 

used in other expressions.  Some parameters should not be evaluated or treated as variables, namely those 

that require a filename, such as dielectric stack information.  Expressions can be used inside complex 
numbers (that is, as two expressions separated by a comma and surrounded by parentheses).  However, if a 

filename is used for a dielectric function, this box should be checked, so that MIST does not attempt to 

evaluate it as a numeric expression.  

5.5 VARIED PARAMETERS Section 

The VARIED PARAMETERS section allows the user to specify parametric variation of any numeric 

parameter. There are two different types of varied parameter elements: the FOR loop and the LIST loop.  

The FOR loop allows a parameter to be varied from a starting value to an ending value with an increment, 

while a LIST loop allows the user to specify a file which tabulates the parameter values for which the 

calculation is to be performed. 

To add an element to this section, the user should select the VARIED PARAMETERS Section, right-

click on the mouse, and select Add.  A dialog box will open to allow the user to specify the loop type: 

 

5.5.1 FOR loop 

A FOR loop enables the user to specify the variable, its range, its increment, and a comment.  If a FOR 

loop is chosen, a dialog box will appear: 
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The variable may be any numeric variable defined in the USER VARIABLES, REQUIRED 
VARIABLES, or MODEL PARAMETERS sections.  The start value, the end value, and the step value 

may be any expression, using any of the variables.   

The order of multiple For Loops may be changed by dragging the items in the tree menu.  The first one 

listed is the most slowly varying parameter, while the last is the most rapidly changing parameter.   

After For Loops have been defined, they will be shown in the FOR LOOPS section of the tree menu. 

For example: 

 

5.5.2 LIST loop 

A LIST loop enables the user to specify a file, which contains a list of parameters and the values that 

they should take.  If a LIST loop is chosen, a dialog box will appear: 

 

The file should be a text file containing whitespace-delimited columns.  The first line should specify the 

parameters that should be varied, and the remaining lines should contain the values that those parameters 

should take.  For example: 

 thetai thetas 
 25 -10 
 25 0 
 25 10 
 30 20 
 30 30 
 30 40 

The variable may be any numeric variable defined in the USER VARIABLES, REQUIRED VARIABLES, 

or MODEL PARAMETERS sections.  In this example, six different combinations of thetai and thetas 
would be used. After a LIST loop has been defined, it will show up in the VARIED PARAMETERS 

section of the tree menu. For example: 

 

5.6 INTEGRALS Section 

The INTEGRALS section defines the integrals that will be evaluated by the program.  There are four 

different types of integrals, HEMI, CIRCLE, POLYGON, and DIFFERENTIAL.  Each integral must be 

given a unique name.  To add a new integral, the user must select the INTEGRALS section, right-click on 

the mouse, and select Add.  A dialog box will open enabling the user to choose one of the four types of 
integrals: 

 

Once the user has defined the integrals, they will be shown on the tree menu as such: 
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Each integral type is described in the following subsections: 

5.6.1 HEMI Integral 

A HEMI integral calculates the reflectance over the entire hemisphere. It has no parameters, other than 

its name, and does not allow for any polarization sensitivity.  The dialog box that opens when the user 

selects a HEMI integral is shown below: 

 

5.6.2 CIRCLE Integral 

A CIRCLE integral integrates the reflectance into a right circular cone centered on a specified direction, 

having a specified half angle and polarization sensitivity.  The polarization sensitivity is given as a four-

element Stokes vector.  The dialog box that opens when the user selects a CIRCLE integral is shown 

below: 

 
All of the angles must be specified in radians.  By default, the variable “deg” is defined to enable one to 

convert a value in degrees to one in radians.  Thus, “45*deg” is π/4 radians. 

5.6.3 POLYGON Integral 

Any arbitrary shape may be specified using a POLYGON integral.  When a user selects POLYGON 

integral, the following dialog box opens: 
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The user must choose a direction by which the polarization is defined and a sensitivity for polarization 

in that direction.  If the integral is to be performed without any polarization sensitivity, the direction can be 

set to theta = 0 and phi = 0, and the polarization sensitivity can be set to (1,0,0,0). 

The vertices of the polygon can be entered by entering directions into the Theta and Phi edit boxes, and 

pressing the Add button.  The direction will show up in the list box.  Once in the list box, a particular 

direction can be highlighted and edited, removed, moved up in the list, or moved down in the list.   

5.6.4 DIFFERENTIAL Integral 

The DIFFERENTIAL integral is not a true integral.  It evaluates the reflectance per solid angle in a 

specified direction.  When a user specifies a DIFFERENTIAL integral, the following dialog box opens: 

 
All of the angles must be specified in radians. 

5.7 OUTPUTS Section  

The OUTPUTS Section defines what quantities are stored and written to the output file for each set of 

integrals.  Generally, they would include all of the integral values specified in the INTEGRALS sections, 
but may also include arithmetic combinations of them or other variables defined the preceding sections.  To 
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choose a new output, the user selects the OUTPUTS section, right-clicks on the mouse, and selects “New”.  
The following dialog box will open: 

 

The label is optional and refers to a new variable that will take on the output value.  The value is any user 

variable, required variable, model parameter, integral, or any arithmetic combination of these.  The output 

of the program (the results file) will consist of columns of values, beginning with the varied parameters and 

followed by the output values specified in the OUTPUTS section. If a label is given, the column will be 

labeled with it; otherwise, the column will be labeled with the expression used for the value. 

After a number of elements have been added, the tree menu will show them: 

 

In this example, the last two items were given labels sum and difference, respectively. 

5.8 FILES Section 

The FILES section allows the user to specify where the results will be written.  When one adds or edits 

an element in this section, a dialog box opens: 

 

There are four different variables allowed in this section: results, listing, samples, and 

header.  The results variable is used to specify the output data file.  The listing variable is used to 

specify a data file for other information that sometimes can help in debugging a simulation.  The samples 

variable is used to specify a file that will contain every BRDF value evaluated during integration. The 

header variable is used to define information that is placed at the top of the output data file.  Multiple 

header variables (simply repeating the header definition) can be used.  If results is not defined, or is left 

blank, the output file will have the same name as the MIST program file, but with the extension .dat. If 

listing is not defined, or is left blank, the listing file will have the same name as the MIST program file, but 

with the extension .lst. If samples is not defined, no such file will be created.  

The following shows the tree menu for the FILES section: 
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6. Running the Simulation 

To begin a simulation, the user should select “Simulate” from the main menu. A progress bar will 

appear: 

 

The user may cancel a simulation by pressing the “Cancel” button.  However, it may take awhile for the 

program to acknowledge that it must stop. 

7. Viewing the Results 

There are three different ways to view the output.  First, one can use a spreadsheet application to read 
the file specified by the RESULTS item of the FILES section.  Secondly, one can view the contents of this 

file in a text window supplied by MIST.  Finally, a rudimentary graph can be displayed, showing the 

outputs as a function of the parametric variables.   

To view the contents in a text window, select View→View Results (Text) from the main menu.    This 
view is useful when one wants to see the specific numbers.   

 

To view a graph of the results, select View→View Results (Graph) from the main menu.   A window 
opens up showing the data as a function of the variable(s) defined in the FOR loops. 

 

The results may be plotted against linear or logarithmic axes. 
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8. Viewing the Sampled Points 

For several reasons, it is often useful to view the sampled points.  For example, one can check to see 

that the integration region matches that which is anticipated.  Also, one might wish to see where the 

intensity is strongest on a detector, and where it is weakest.  For these reasons, MIST provides a view of the 

scattering hemisphere with the integrations points shown with their intensities.  To view the sampled 

points, select View→View Sampled Points from the main menu.  A window will appear: 

 

By default, the integration points are shown over the scattering hemisphere as viewed from the surface 

normal.  By sliding the viewing angle and the viewing rotation slider bars, the direction over which the 

hemisphere is viewed can be changed: 

 

The incident plane is shown with a dark curve starting at the surface normal.  The incident and specular 

beams are shown with green line segments, and the points that the incident and specular beams intersect the 

hemisphere and the sample are shown as circles. 

Index refers to the step index of the FOR loop.  By changing the index, one can view the intensity or the 

shape of the integration domain as a function of the varying parameter. 

By pressing the Options button, some parameters used for displaying the sampled points can be 

changed: 
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Show Intensity—Checking this box will show the integration points with points whose gray scale 

depends upon the intensity, while un-checking it will show the integration points in black. 

Show Intensity as BRDF—Checking this box will show the gray scale (if the Show Intensity box is 

checked) corresponding to BRDF, while un-checking it will show it corresponding to intensity. 

Invert Intensity Scale—Checking this box will make the gray scale be whiter when the intensity is 

higher, while un-checking it will show the more intense points darker. 

Always Auto-Scale—Checking this box will ensure that anytime the image changes (due to calculation 
or looking at a different step), that the results will be auto-scaled over the range of intensities. 

Fix Zero Intensity on Auto-Scale—Checking this box will set the lowest intensity scale to zero, while 

un-checking it will set the bottom of the scale to the lowest intensity shown. 

Data point size—This parameter sets the size of the circles used to show the integration points.  By 

default, this value is 100.  One can effectively show a map of intensity by setting this number so that the 

points fill the gaps between adjacent points. 

9. Expressions 

All parameters in MIST are treated as expressions which are evaluated each time they are needed.  

These expressions can use any of the binary arithmetic operators listed below, listed in order of precedence, 

with each row indicating items having the same precedence: 

x^y power     
x*y multiplication x/y division   
x+y addition x-y subtraction   
x>y greater than x<y less than x=y equal to 
x&y and x|y or   

  

Parentheses can be used and nested to any degree.  The table below lists functions which can be used in the 

expressions: 
exp(x) Exponential  log(x) Natural logarithm 
log10(x) Base-10 logarithm sqrt(x) Square root 
sin(x) Sine  sind(x) sin(x*pi/180) 
cos(x) Cosine  cosd(x) cos(x*pi/180) 
tan(x) Tangent  tand(x) tan(x*pi/180) 
asin(x) Arc-Sine  asind(x) asin(x)*180/pi 
acos(x) Arc-Cosine  acosd(x) acos(x)*180/pi 
atan(x) Arc-Tangent  atand(x) atan(x)*180/pi 
sinh(x) Hyperbolic Sine cosh(x) Hyperbolic Cosine 
tanh(x) Hyperbolic Tangent atan2(y,x) Polar angle of the point (x,y) 
atan2d(y,x) atan2(y,x)*pi/180   

 

Table lookup can be accomplished using the @filename(x) and @filename(x,i) functions.  If the 

first is called, then the program will assume the first two columns of the file filename contains an 
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interpolation table.  If the second is called, the program will use the first and i-th columns for the lookup 

table.  

10. Accuracy 

While most of the BRDF models contained in the SCATMECH library are based upon physical 

principles, most are approximations that have a limited range of accuracy.  It is up to the user to assess the 

accuracy of each model to determine if the results he or she obtains are of quantitative value or are just 

qualitative guides to data trends.  

Aside from the intrinsic accuracy of the particular model, the accuracy of the integration depends upon 

the values of the variables SOLIDANGLE and MINSAMPLES, any structure in the scattering within the 

integration solid angle, and the shape of the integration solid angle.  The program chooses the number of 

sampled points by dividing the solid angle of a right circular cone that circumscribes the integration solid 

angle by the variable SOLIDANGLE, assuring that this value is above MINSAMPLES.  It then samples 

directions on a square grid within this right circular cone.  If the point is outside of the integration solid 
angle, it returns zero intensity for that direction.  The results are adjusted by the ratio of the calculated 

projected solid angle (as determined by the sampled points) and the actual projected solid angle of the 

desired shape, as determined by a path integral around the perimeter. 

11. Examples and Other Notes 

11.1 Specifying material properties 

In all of the examples, complex material indices of refraction are specified by constant values.  The 

SCATMECH library, however, allows the use of external files which contain the optical constants as 

functions of wavelength.  Such a file should be a text file containing three tab-delimited columns, in which 

the first column represents the wavelength, the second column the index of refraction, and the third column 

the absorption coefficient.  The optical properties of the substrate, for example, can then be specified by the 
following model parameter declaration 

 

The “Transfer directly as a string to model” box must be checked, or MIST will try to interpret “silicon.txt” 

as a numeric expression.  In this manner, the VARIED PARAMETERS section statement 

 
will allow the reflectance to be calculated over a variety of wavelengths even though the optical properties 

of the substrate are wavelength dependent. 

11.2 Use of Local BRDF Models 

Any of the SCATMECH models which inherit the class Local_BRDF_Model (such as 

Bobbert_Vlieger_BRDF_Model or Rayleigh_Defect_BRDF_Model) calculate the differential 

scattering cross-section (DSC) rather than the BRDF.  The class Local_BRDF_Model uses the parameter 

density to convert the DSC to BRDF.  If one is interested in the integrated cross section for an isolated 

particle or defect, then one should set this parameter by 

 

If, instead, one is interested in a net effective reflectance, when the effective beam area is area, then one 

should set this parameter by 
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11.3 Calculated Integrated Scatter by Isolated Particles 

While MIST was not designed with isolated particles in mind, with a little insight and knowledge of the 

SCATMECH models, it can effectively be used for that.  If the incident angle is 90°, the transmission 

hemisphere will be symmetric with the reflection hemisphere.  The subsurface sphere model effectively 
performs the scattering by a free space sphere embedded in a transparent substrate, and that substrate can 

be set to have a unit index.  Since the model calculates the BRDF, before calculating differential 

reflectance, the incident angle must be set to a value close to, but not equal to 90°.  The example code in 

particle.mist illustrates this procedure.   

11.4 Calculating BRDF 

MIST can be used to calculate BRDF by using a DIFFERENTIAL integral, using a sensitivity of 

1/cos(θs): 

 

 

The example code brdf.mist can serve as a template for BRDF calculations. 

 

11.5 Calculating Stokes Vector BRDF 

Stokes vector BRDF may be calculated using four differential integrals, each with sensitivity to a 

different element: 

 
The example code stokes_brdf.mist can serve as a template for Stokes vector BRDF 

calculations. 
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11.6 Calculating Mueller Matrix BRDF 

Mueller matrix measurements can be obtained as for Stokes vector BRDF measurements by looping 

through an index that selects the incident Stokes vector: 

 

The example code mueller_brdf.mist can serve as a template for Mueller matrix BRDF calculations. 

11.7 Calculating Integrated Cross Section for Particles on Surfaces 

One application of MIST is to develop response curves for light-scattering-based particle scanners.  

These devices have a relatively collimated beam incident on a sample and collect scattered light over a 

relatively large set of directions.  The scattered signal is often attributed to the presence of particles, and the 

signal can be correlated with the size of the particle.  It is often useful to estimate the signal that one would 

expect for different sphere sizes.  The example code scanner.mist is an example of such a calibration, 

using the Bobbert-Vlieger theory for scattering by a sphere on a surface.  The code integrates the scatter 

between polar angles narrow = 25° and wide = 70° for particle diameters from 0.05 µm to 0.350 µm. 

11.8 Calculating Diffraction Efficiency for a Grating 

Version 6.00 of SCATMECH added Rigorous Coupled Wave (RCW) analysis of gratings to its suite of 

capabilities, through the classes RCW_Model and Grating. Because gratings inherently have BRDFs 

that behave like delta functions, and because MIST does not handle delta-function-like BRDFs, the class 

RCW_BRDF_Model was created, which casts the theory into a form acceptable to MIST.  In short, it 

spreads the reflectance into a finite cone with a half-angle given by the parameter alpha. 

To calculate diffraction efficiency using MIST, one can start by examining the example code 

grating.mist.  It solves for the diffracted direction using the diffraction equation: 

 

It then calculates the diffraction efficiency by evaluating the effective BRDF in the diffracted direction, 

correcting for the solid angle over which the light is spread: 
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12. Legal Disclaimer 

The MIST and SCATMECH software packages were developed at the National Institute of Standards 

and Technology by employees of the Federal Government in the course of their official duties. Pursuant to 

Title 17 Section 105 of the United States Code this software is not subject to copyright protection and is in 

the public domain. MIST and SCATMECH are experimental systems. NIST assumes no responsibility 

whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its quality, 

reliability, or any other characteristic. We would appreciate acknowledgment if the software is used. This 

software can be redistributed and/or modified freely provided that any derivative works bear some notice 
that they are derived from it, and any modified versions bear some notice that they have been modified. 

13. Registering MIST 

Registration of the NISTMIST program is voluntary and enables you to be notified when new versions 

are released. It also enables you to provide feedback that helps us improve the library and its 

documentation. To register, send an e-mail message to thomas.germer@nist.gov, indicating your interest in 

registering your copy of the software.  

14. Version History 

14.1 Version 1.00 

Version 1.00, the original version of MIST, was released in June 2004. 

14.2 Version 2.00 

Version 2.00 was released in July 2005 and represented a major upgrade.  The program was changed to 

include a graphical user interface and was linked with SCATMECH version 5.00. 

14.3 Version 2.10 

Version 2.10 was released in August 2005 and represents a minor bug fix to MIST and SCATMECH.  

The rotation of the polarization sensitivity over a finite solid angle was miscalculated in previous versions.  

This version was linked with SCATMECH version 5.01. 

14.4 Version 2.20 

Version 2.20 was released in July 2006 and represents a minor bug fix to MIST and SCATMECH.  

Prefix negative signs in some expressions were not handled correctly.  This version was linked with 

SCATMECH version 5.02. 

14.5 Version 2.30 

Version 2.30 was released in August 2006 and represents a minor bug fix to MIST and SCATMECH.  

The BRDF sampling file capability was restored, and file writing was significantly sped up. This version 

was linked with SCATMECH version 5.03.  
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14.6 Version 3.00 

Version 3.00 was released in December 2007 and includes minor changes to MIST and compilation 

with a new version of SCATMECH.  This version was linked with SCATMECH version 6.00.  The main 

change to the MIST code is that it now includes the ability to rename the outputs.   

14.7 Version 3.01 

Version 3.01 is a service update, incorporating a minor SCATMECH change.  This version was linked 

with SCATMECH version 6.01. 

APPENDIX 
 

Figure 2 provides a graph of the spherical coordinates of the reflectance hemisphere.  This diagram is 

useful for planning calculations.   
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FIGURE 2  The reflectance hemisphere. 


